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WHY LEARN MORE 

Excel is a tool with unlimited potential for enhancing business in today’s 
quickly evolving global scene. Companies and their employees are 
leveraging the power of Excel for better success and results in very rapidly 
changing or competitive business environments. Excel users with 
intermediate to advanced skills in data analysis are growing in demand as 
businesses come to rely more on those who can crunch data in meaningful 
ways. With the power of Excel, businesses can help identify opportunities 
for expansion, save money, investigate deficiencies and overall help in the 
making of important business decisions. Many companies and employees 
are relying more on the automation and broad functionality of Excel to 
reduce workload, plan projects or manage records in their business 
operations. The sky is the limit, both for utilization in business and learning 
more. There are many ways to expand one’s own Excel horizons, from 
instructor led courses in the classroom to independent study online.  
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MORE EXCEL FEATURES 

 

� Calculations 
� Inventory 
� Invoicing 
� Forecasting 
� Data Analysis 
� Charting 
� Graphical Analysis 
� Operational Tools 
� Limited only by imagination 
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BASIC LINGO 

It’s just terminology and often has a simpler explanation than what it 
appears to be at first glance.  

Sort & Filter 
The Sort Tool sorts data 

automatically by date, number and 
more. The Filter Tool filters data to 

isolate, analyze and compare 
information within a column. 

 

 Tables 
Converting a range of cells 
containing data into a Table will give 
you instant command of tools for 
further sorting, filtering, managing 
and analyzing groups of data. It’s a 
sometimes a little easier on the eyes 
to look at data in a Table format.  
 

Functions 
Functions are pre-defined 

formulas that are built into Excel 
and used for automating simple 

and complex calculations.   

 

 Pivot Table 
A powerful tool that queries, 
organizes analyzes, and summarizes 
data to see patterns, identify trends, 
and make comparisons.  



 

 

 
 

SORTING 
TOPICS INCLUDE 

 

 

 

 

      

 

  

 Sorting Information 
 Sorting by Data Type 
 Advanced Sort 
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SORTING INFORMATION 

Grouping like information together or ordering it from smallest to largest  or vice 
versa is one of the quickest tools that can be used in Excel. It just takes a few 
seconds to sort a column as only one cell needs to be selected in that column before 
sorting. If multiple cells are selected before completing a Sorting feature in Excel, 
you will see a dialog that will ask you to confirm or expand the selection. One 
selected cell is all that is required to start a Sort. 

Sorting data can be done multiple ways in Excel. Using the A to Z and Z to A buttons 
is probably the quickest way to sort a column of data. These two buttons do feature 
sorting alphabetically,  but they are also capable of sorting dates, numbers, along 
with text. It will depend on what cell is selected before pressing the sorting buttons. 

 

1. Click in the column that needs to be sorted 
2. Select A to Z button to sort these types of data 

a. Alphabetical 
b. Smallest to Biggest 
c. Oldest date to newest date 

Dept Column before Sort A to Z Dept Column after Sort A to Z 

  
  

 
 

  



Intermediate Excel  Silvera Training 

 7 

ADVANCED SORTING 

With the Custom Sort feature, multiple columns and options for sorting 
are available. Sorting month and weekday names will automatically sort 
the data      alphabetically,      leaving the months out of order. Using the 
SORT button on the Data Tab will activate the Custom Sort dialog. 

 

Much like the Filter feature of Excel, The Sort dialog can sort by      
properties other than just the Cell Value. 

Cell Value – Text, Number or Date 
Cell Color – Sort by the Same Fill colour 
Font Color – Sort the cells using the font colour 
Conditional Formatting Icon – Group all the like icons together applied using 
Conditional Formatting 
Options Button – Sort by rows or even column headers  

This data has been sorted first by the Dept. column and then within the 
department the date has been sorted Newest to Oldest.  
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FILTERING 
TOPICS INCLUDE 

 

 

 

 

 

 

 

 

 

  

 Using Filters 
 Filter by Data Type 
 Applying Filters 
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FILTERS 

The Filters are drop-down menus that can appear on the header row of data. 
They are a very common feature in other tools within Excel and will be 
operated in the same way, wherever they are found. The Filters have both the 
capability to sort and can also hide rows of data, showing only the pertinent 
information that needs to be seen. 

Clicking once inside of a data set and pressing the Filter button found on the 
Data Tab will activate the Filters at the top of the data on the header row. If 
Excel detects no row for the header names, it will add generic titles like 
Column 1 and Column 2.  

FEATURES OF THE FILTERS 

● Hide/Show data by criteria 
● Partial word search 
● Sorting 
● Specific Filters based on the data type. Text, Numbers and Dates 
● Filter for blank cells 
● Filtered data will show BLUE column numbers 

  

 

Header with Filters 
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FILTER BY DATA TYPE 

Text, Numbers and Dates all have Filter types that are specific to the 
respective data type. Showing data using these are a form of an advanced 
query that can be used.  

Text 
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Numbers 
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Dates 
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APPLYING FILTERS TO DATA 

 

1. Click in a cell within the data. Ensure that there are no full blank rows 
or columns as they will not be part of the Filter. Alternatively, all the 
data including the headers can be selected, if Excel needs 
clarification on what should be part of the filter. 

2. Operated the drop-down Filters to show/hide specific data. Sorting is 
also available. 

3. Clearing the Filter, when necessary, can be done in the drop-down on 
the Filter button or in the Sort and Filter group on the Data tab � 
Clear 
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TABLES 
 

 Table Info 
 Benefits of using a Table 
 Table Options 
 Table Design 
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TABLE INFO 

When data is ordered into rows and columns, some users will call the data 
a table. By converting a normal range of data into a Table, multiple tools 
and benefits are available. Tables consider the data as a group rather than 
a bunch of cells and makes the dataset updateable as the Table will grow 
when rows or columns are added.  

 

BENEFITS OF USING A TABLE 

▪ Data automatically expands the Table when new rows or columns are added 
▪ Formulas and formatting carry down to the next row 
▪ Total Row feature can be turned on to run math functions using a drop-

down menu 
▪ Header row freezes at the top when scrolling through a Table 
▪ Filters are turned on when a Table is created 
▪ Using the Filters and the Total row a Table can be used to query data for 

answers 
▪ Formulas AutoFill automatically down a column 
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▪ Banded Rows/Columns make it easier to visually follow a large row of data  

TABLE DESIGN TOOLS 

Once a Table has been selected by clicking on one or more cells inside the 
Table, a set of Table tools show up on the Ribbon at the top right. One of 
the most important features in the Table tools could be the check box that 
toggles on and off the Total row, enabling math to happen automatically at 
the bottom of the data.  

After a Table has been created the Total row can be Toggled on/off using 
the checkbox in the Table Design Tools. To activate the features of a Table 
including displaying the Table Tools on the Ribbon, click inside of a Table 
of data. 

 

PROPERTIES 

 

Table Name 

All Tables get a name automatically when created, 
Table3 is an example of one of the unique names a 
Table is given. It is possible to rename a Table. 
Columns also have a reference generated 
automatically based on the name in the header row. 

Resize Table 
Add columns or rows that are not already part of the 
Table. It is not often necessary to resize a Table 
because Tables automatically grow as data is added 
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TOOLS 

 

Summarize with 
PivotTable 

A Pivot Table is a form of a Table with advanced tools 
for organization and summary analysis of data. 

Remove Duplicates 
The Remove Duplicates tool works on regular cells 
and table data. There are more advanced tools and 
techniques that are built-in to Excel 

Convert to Range 
Convert the Table back to a regular range of Data. It 
could still look like the original Table because the 
formatting will stick around. 

Insert Slicer 
A Slicer is a set of buttons that allow filtering to take 
place indirectly.  

EXTERNAL TABLE DATA 

 

Export 
Send the Data to Microsoft Visio Pivot Diagram or 
export the data to Office 365 SharePoint list. 

Refresh 
If the external data sourcing a Table has changed, the 
Table will need to be Refreshed. 

Properties Details about the external data connection 

Open in Browser 
Open the external data source 

Unlink 
Break the connection to the external data and stop 
updating 
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TABLE STYLE OPTIONS 
 

 

Header Row 
Turns of the headers. Useful if two tables with the 
same headers need to be combined 

Total Row 

Turn on the Total Row to automatically run Functions 
below the bottom row of the data. SUM, MIN, MAX, 
AVERAGE, COUNT, Variance and Standard Deviation 
Functions are available. Turn off the Total Row to 
easily add data 

Banded Row 
Every 2nd row is a light or darker colour. Some design 
in the Table Styles do not show Banded Rows. 

First Column  
The first column will be formatted differently than the 
following columns. Some designs offer      a darker fill 
colour and some just bold the text/data. 

Last Column 
The same as the First Column feature but changes 
the look of the last column. 

Banded Columns 
Every 2nd column is a different colour or look. Not all 
styles show lighter/darker banding. 

Filter Button 
The Filters from the Data tab show up automatically 
when a Table is created. No need to go to the Data 
Tab to toggle the Filters, use the Filter button 
checkbox. 

  

 
 



Intermediate Excel  Silvera Training 

 19 

TABLE STYLES 
Formatting data takes times and Tables will do most of the work. When 
data is added the design will carry forward to new rows or columns. 

 

 

 

The down pointing arrowhead icon will 
display the available styles. 
Options like Banded Rows  
will affect the presets 

 

 

Table style presets 
Choose from multiple presets to change the look of 
the Table quickly. The check boxes to the left of the 
Table Styles will change the look of the presets. 

Create New Table 
style 

The drop-down for Table Styles has a few more tools 
including the ability to create a Table Style preset 

Clear Table Style 
The drop-down for Table Styles has a button to clear 
the fill and border formats from a Table. The data will 
still be in a Table but will look like regular cells. 
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FORMULAS/FUNCTIONS IN COLUMNS 

Tables do not use normal cell references when applying a Formula or a 
Function to a column of data, they act more like formulas in database 
software such as MS Access or MS Project. Some newer users of Excel 
find it easier to complete the formulas before converting data to a Table. It 
is not necessary to do a SUM or related Function at the bottom of the data 
as Tables have the built-in Total Row feature. 

The references to the cells will be done by the name of the column 
heading. A formula can be applied to new column the same way as it is 
done on regular non-table cells. After entering the formula, Excel will 
automatically AutoFill down to the bottom of the Table. Even though no 
specific cell reference is used, AutoFill will apply the formula relative to 
each row. The @ symbol is an instruction to the formula to get the data 
from the row the formula is in. No need to write the column name or use 
the @ symbol when selecting cells with the mouse when writing formulas 
or functions. 

 

The new Spill Functions added in 2019 version are not compatible with 
Tables. 
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FILTERS 

Filters really are a separate tool that happen to be applied automatically to 
Tables. The Filter feature in Tables operates the same as they do on a 
regular range of data along with features like freezing the header row so 
that it is visible when scrolling through a larger set of data. It also includes 
a Total Row to display the totals of the filtered data.  
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SLICERS 

 

Slicers are buttons that can utilize the Filters indirectly 
without the need of using the drop-down for the filter on the 
Header Row. By pressing the Slicer button on Table Design 
tools, a dialog appears to select the columns by the header 
name to make the Slicer button show up.  

 

 

To delete a Slicer, click on the Slicer and press delete on the keyboard. 
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FUNCTIONS 
  

 AutoSum and Friends 
 IF Function 
 Lookup Functions 
 Spill Functions 
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INFO ABOUT FUNCTIONS 

Functions are built in Math and Logic that are initiated by the functions 
name along with a set of parameters to tell the function what data to 
calculate. With just under 500 Functions in the 2019 and Office 365 
version of Excel there is some of the Functions every Excel user should 
know and many that are for specific situations or industries. 

A function can have the capability of referencing a group of cells in a row 
or column by using a semicolon. It would be impossible to add thousands 
of rows of data using a regular math formula = A1 + B1 + …  

COMMON FUNCTIONS 

SUM AND THE AUTOSUM FUNCTIONS 
SUM is the most used Function in Excel. It is the only Function that has a 
shortcut, ALT + =. The main difference between using SUM and a regular 
formula is that the SUM function can use a range of rows, columns or both 
and a math formula would have to reference every cell individually. 

The AVERAGE Function is a good example on how it is possible to supply 
the cells with the numbers that need averaging to the AVERAGE Function 
and all the math needed to average happens behind the scenes and only 
returns the answers. It is no longer necessary to use math formula of 
adding up all the numbers and dividing by the count of numbers as taught 
in early grade school. 

Average using a non-Excel math formula to average three numbers 

(2+3+10)/3 

Using the AVERAGE Function to average ninety-eight cells of data 

=AVERAGE(B2:B100)  
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SUM FUNCTION 

The SUM Function, the most used function, has the capability of referencing a 
group of cells in a row or column by using a semicolon. It would be impossible 
to add thousands of rows of data using a regular math formula = 
A2+A3+A4+A5+A6+… until A1001 

The SUM function can add up thousands of rows of data in a short formula.  
This will add up cells in rows A2 to A10000  

=SUM(B1:A10000) 

 SUM Function Examples 

=SUM(B2:B10000) 
Sums almost 10 thousand of numbers in a column 

=SUM(B2:M2) 
Sums 12 cells that are in row 2 

=SUM(B2:D100) 
Sums rows and columns from B2 to D100 (297 cells) 

=SUM(B2:B100,D2:D100) 
Sum up 99 cells in column B and 99 cells in column D 

=SUM(D2,E2,F2) 
Sum up three different cells. A math addition formula 
would have worked here also but use the SUM 
function if there is a range of adjacent cells 

=SUM(B2:B10)*0.05 
SUM B2 to B10 and then multiply by 0.05 (5%) 

=SUM(B2:B10)>100 
The SUM will add up the number and the greater than 
and 100 will run a test that will result in either TRUE or 
FALSE as the answer 

Many of the Functions are like how the Arguments work inside of the SUM 
Function. Average, Min, Max, and Count use the same argument structure but 
will produce a different answer based on the Function. An incorrectly entered 
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function will show the error #NAME, which is Excel telling you that it doesn’t 
understand what was typed. 

BASIC FUNCTIONS 
� SUM 
� AVERAGE 
� COUNT NUMBERS (COUNT) 
� MIN 
� MAX 

POPULAR FUNCTIONS 
� IF 
� VLOOKUP 
� SUMIF 
� TODAY  

 

Explore the different categories found under the Formula tab on the 
Ribbon.  Adding a Function is the next topic and will show the Formula 
Tabs Function Library in more detail. A listing of all the available Functions 
can be found on Microsoft’s website, in alphabetical order. 

https://support.microsoft.com/en-us/office/excel-functions-
alphabetical-b3944572-255d-4efb-bb96-c6d90033e188  

 

  

https://support.microsoft.com/en-us/office/excel-functions-alphabetical-b3944572-255d-4efb-bb96-c6d90033e188
https://support.microsoft.com/en-us/office/excel-functions-alphabetical-b3944572-255d-4efb-bb96-c6d90033e188
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EXAMPLES FUNCTIONS 
Built-in logic to add smarts to your spreadsheet can be entered into the 
cells where the answer is to be displayed. After entry the Function or 
formula will disappear showing only the answer 

 

  

Data used for 
examples: 
Column C  

cells C2 to C1100 

Functions 
showing answers 
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ADDING A FUNCTION 
There are several ways to add a Function to a cell. See below for more information 
about applying the AutoSum button to a cell. 

AUTOSUM BUTTON 
 AutoSum is a virtual one-click addition of your data. When triggered, AutoSum 
intuitively selects and adds up your data, with the resulting value 
returned into the answer cell, where AutoSum was applied. 

To add a SUM Function to a cell. click into the cell where you would like 
result returned, and then click the AutoSum button in the ribbon. There 
are five more important automated functions in the drop-down menu of 
the AutoSum button.  

HOME & FORMULA TAB ON THE RIBBON TOOLS  

AutoSum on the Home Tab  

 

Smaller laptops/screens will show the same icon without the label 
AutoSum 

 

AutoSum on the Formula Tab 
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INSERT FUNCTION BUTTON 
Found to the left of the Formula bar,       Insert Function has     search and 
help capabilities 

 

 

  

Search by name or 
keyword  

Help and Reference 

Browse by Category 
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After selecting the desired Function, the Function Arguments Dialog 
appears. Fill in the required arguments and press OK to complete. Help on 
the Function is also available in the bottom left corner if reference is 
needed to understand the argument required. Clicking in each field shows 
a brief description of that specific argument. Many find the Help button 
more useful for reference. 

You can return to this dialog after the Function has been completed to edit 
what was entered. Edit by selecting the cell or editing the cell that contains 
the Function and pressing the same Insert Function button to left of the 
Formula bar.  
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FORMULA TAB 
The Function Library allows you to Explore Functions by category. The 
Insert Function dialog will appear after a Function is chosen. 

 

TYPING 
Start typing the Function in a cell or Formula Bar. Typing is the only 
method of adding a Function that will autocomplete the names of the 
Function along with several other drop-down lists to choose options from. 
Function names and Named Ranges will pop-up when typing a formula. 
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USING THE AUTOSUM BUTTON 

Apply a Function from the Home or Formula Tab (Ribbon). – AutoSum button 
This includes all the five basic functions: SUM, AVERAGE, MIN, MAX, and COUNT 
NUMBERS. 

The Auto part of AutoSum and the related functions, Excel will automatically select 
cells adjacent to the cell where the answer will show. AutoSum often will include 
cells that are not 

1. Click – click on the cell you want an answer in 
2. Select – Select a Function using the AutoSum button 
3. Correct – Correct the selected range if necessary 

 

While inserting a function you will have a chance to select the cells in step 
3 when needed. 

  

Step TWO:  
Choose a Function 

2 

Step ONE:  
Select a cell 

1 

Step THREE:  
Correct if necessary 

 

PRESS ENTER 

3 

4 
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REFERENCING CELLS 
Formulas and functions and tools will use cell range references. Math 
formulas do not reference a column or row of data like some of the 
Functions and tools are able to reference a whole column. When you are 
selecting cells with mouse, Excel will write the cell references for you. To 
show a more realistic example the SUM function is used for demonstrating 
cell referencing as it is one of many functions that can use a range of more 
than one cell. 

It is possible to use numbers directly in formulas and functions in Excel and 
is acceptable to do if the number is not going to change often. Cell 
references have two main advantages 

1. The formulas/functions will not have to be updated if the data 
changes 

2. AutoFill will fill in similar rows or columns with the same 
formula/function but change the reference so that it applies to the 
new row/col 
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Example Cell References 

Same Sheet =B2  
Column using 
SUM =SUM(C2:C10) 

The SUM function is referencing and 
adding up row C2 all the way to C10. This 
is a lot shorter than using addition 
because of the column ref. 

Row/col using 
SUM =SUM(B2:J100) The SUM function is adding up multiple 

rows and multiple columns. 

   

Different Sheet 

='Expenses 2021'!E11 

This is what is referencing a cell from 
another worksheet in the same workbook. 
The worksheets name is separated from 
the cell address by an exclamation mark. If 
the Worksheet name has a space in it, 
single quotes will surround the name. 

Different 
Workbook ='[More Data.xlsx]data 

sheet'!$E$11 

This references CELL E11 from the More 
Data workbook.xlsx file within the data 
sheet worksheet. 
[Workbook]worksheet!E11 

Named Ranges 

=SUM(NameOfCells) 

Naming cells has many benefits, discussed 
later. Named Cells are a form of an 
absolute reference. Both topics are 
mentioned in this manual. 

This is not an exhaustive list of ways to references cells in a Worksheet or 
within a workbook. The above examples show three main ways to 
reference a single or a group of cells. If a cell reference contains a $ in the 
cell references, that      is a locked in reference used in the next topic, called 
AutoFill Formulas 

� Same Worksheet: E11 or $E$11 (both point to cell E11) 
� Different Worksheet: [Workbook Name]Worksheet Name!Cell Address 
� Different Workbook: [Workbook Name]Worksheet Name!Cell Address  
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IF 

The If function is the most popular logic function which can test one cell to 
see if it meets a criteria and then will give one of two answers. Test a cell to 
see if it contains more than 40 hours and IF it does, calculate      overtime 
and IF it doesn’t don’t pay overtime. An IF Function can output a TRUE or a 
FALSE answer. Those answers can set to show a text, number, cell 
references, formula or even another Function. 

Three Arguments 

=IF( LOGICAL TEST , VALUE IF TRUE , VALUE IF FALSE ) 

1. Logical Test  - The test will result in a TRUE or FALSE Answer. 
2. Value if TRUE – If the test gets a TRUE answer this value will show 
3. Value if False – If the test gets a FALSE answer this value will show 

Comparison Operators work in many areas of Excel including 
Functions/Formulas and some of the tools in Excel. 

Comparison Operator  Symbol 
Equals = 

Not Equals <> 

Greater Than > 

Greater Than or Equal To >= 

Less Than < 

Less Than or Equal To <= 
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An IF Function uses comparison operators to test a cell. When CELL 
references are used this question of overtime can use the AutoFill feature 
to fill in the adjacent rows. 

=IF(B2>40,"Yes","No") 

Quotes are used for the True and False answer in the example as they 
output text. If Functions that output numbers, formulas or functions, are 
recognized directly by Excel and will not need quotes. 

Testing to see if a cell has a value greater than 40, if so, the answer is Yes 
and if not, the answer is No 
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EXAMPLE IF FUNCTIONS 
The IF Function is a very versatile Function that has many variations. It can 
test Text, Numbers, Formulas, Cells against other CELLS and even tell if a 
CELL has been left blank.  

Example IF Description 

=IF(B2="Canada",5%,0) 

Checks cell B2 to see if it 
contains the text Canada. 
Notice anytime text is used it 
features the double quotes. 
If B2 is Canada, the cell that 
contains this Function would 
output 5% 

=IF(B2<=100,”Small”,”Large”) 

The logical test checks to 
see if cell B2 is less than 100 
and if it is than set the 
Function cell to the word 
Small and anything else will 
get Large. 

=IF(B2='''',”Please Fill in Cell B2”,”Thank you”) 

The double quotes with no 
space between them 
represent BLANK. This 
example is testing cell B2 to 
see if it is left blank, if it is 
than it politely reminds the 
user to fill it in. When cell B2 
is filled with any data the 
Function cell will say Thank 
you. 
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=IF(B2>=C3 , "Target Met" , "Keep Going") 

The logical test compares 
two cells to see if the B2 is 
equal to or       greater than 
the target set in C3. If it is 
than the answer cell will 
contain the words Target 
Met and default to Keep 
Going, if not. 

=IF(B2>=TODAY(),"Due Now","pending") 

Test a cell with a date to see 
if it is greater than or equals 
to Today's date. Functions 
and formulas can be used in 
all three arguments. This 
example has the TODAY 
function in the logical test. 

=IF(B2="Complete","✔","❌") 

The if Function can output 
any text including symbols. 
All symbols will be the font 
colour of the cell. It is 
possible to use conditional 
formatting to make the 
check mark green and the X 
red, formatting is not done in 
the Function itself. 
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IF(B2<50,"Small",IF(B2>100,"Large","Medium")) 

This is a what is considered a 
Nested Function. The first 
logical test will check B2 to 
see if it is less than 50, if it is 
NOT then it will run the 2nd IF 
function that tests to see if is 
greater than 100. If B2 is not 
greater than 100 it will 
default to Medium. The 2nd IF 
is located inside the FALSE 
position of the 1st IF.  

Notice in all the examples whenever text is used it has been double 
quoted. Text and symbols will have to be protected by the quotes as Excel 
will output the #NAME error there is something in the formula or Function 
that is not understood. 

The IFS Function was added to Excel in 2019 and can be a great alternative 
to creating a more complex nested IF Functions. 

The following IFS example tests CELL B2 twice with two possible 
outcomes. If neither test gets a pass, the answer defaults to 16. 

 

=IFS(B2="Contract",32,B2="Fulltime",28,TRUE,16)  
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CONDITIONAL FUNCITONS 

SUMIF, AVERAGEIF, COUNTIF are examples of Functions that will only 
calculate data on a given condition/criteria that could even come from a 
corresponding column. The SUM Function will add up everything in a 
column where the SUMIF could be given the condition to only add up 
specific costs from.      

The SUMIF and family of conditional functions often need more than one 
column, using Named Ranges is helpful when working with frequently 
selected and large sets of data. It also helps simplifying the user writing 
and reading the functions. 
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COUNTIF 
CELL F6 looks through B4 to B9 and counts how many times the word 
Laptop shows up. The criteria can be from a CELL E6 or typed directly into 
the CountIF function. 

CELL F6 - =COUNTIF($B$4:$B$9,E6) 

SUMIF 
CELL G6 looks through B3 to B9 and matches the criteria of Laptop. When 
Laptop is found the SUMIF will add it to the SUM of Laptop.  

CELL G6 - =SUMIF($B$4:$B$9,E6,$C$4:$C$9) 
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VLOOKUP 

Looking up information is a daily occurrence in business and even in our 
personal lives. Using a catalog to lookup a price or a phone book to look up 
a phone number would be examples of a lookup. Companies create many 
types of datasets and databases that can be used to lookup a unique 
product number, name, or data. It is important that the source of data has a 
unique identifier in the first column such as an employee ID number or a 
product UPC number. The V in VLOOKUP stand for a vertical lookup as it 
searches through a column vertically starting at the top cell in said column. 

=VLOOKUP(C4,$I$5:$K$8,2,FALSE) 
=VLOOKUP(C4,ProvTaxDB,2,FALSE) 
4 arguments 

A What are you looking up 
B Where is the data 
C What column # returned 
D Approximate (TRUE) or Exact Match (FALSE) 

A Database has a unique identifier such as a Product ID #, Province, or 
department name, in the first column.  
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The following example will use a simple product ID #. Some of the data in 
the columns of this list of products will have to be looked up to complete 
an order sheet.  

There are four columns in the Product DB, VLOOKUP will need to know if it 
is column 2, 3, or 4 that the answer should be pulled from when a match is 
found. 
If a match is not found the VLOOKUP Function will output the #NA error. 

 

Having to look up products by the ProdID Field could be time consuming if 
done manually. Writing a Function that looks up the first product ID can 
use AutoFill to complete the following products that also need to be 
looked up.  
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Another VLOOKUP Example 

The following example show VLOOKUP looking up product ID #1006 in 
cell B5, it uses CELLS H5 to K8 but only looks in the first column to match 
the number. When it finds the match, the Function asks for the answer 
from COL 2 and is set to FALSE for an exact match 
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SPILL FUNCTIONS 

In 2019 Excel updated the Functions by adding Functions that could 
output to more than one CELL. Before Spill Functions existed this 
capability of querying data and outputting a new list of results, was 
reserved for tools, Array Formulas or VBA programming.  

Spill Function needs room below or sometimes beside where the Function 
is typed as the answer will spill-out into the necessary number of cells 
needed to. If there is not enough room the #SPILL error will show and if 
the Function needs editing or deleting it must be done in the first cell in the 
array of answers. 

2016 and older versions of Excel do not support the Functions added to 
Excel in 2019 and beyond. Ensure compatibility when collaborating with 
other users. Excel online and their competitor Google Sheets support 
more Functions than Excel 2016 and older. Most of tools in Excel are also 
available online, but not all. 

UNIQUE 
Use the unique Spill Function on a list on text, names, dates, or numbers to 
output only one of each.  

=UNIQUE(A2:A9) 
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FILTER 
The Filter Function first specifies the whole data set, and the second part 
tells the Function what column and criteria to look for. When the criteria 
are met, the Filter Function can output multiple rows and columns of data. 
Make sure to leave lots of room for the output. This new Function can do 
some of the work that an older tool called Advanced Filter was capable of. 

=FILTER(A2:B9,A2:A9="Hamill") 
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SORT 
The Sort can reference a column/row of data and output it in various types 
of chronological, number, or alphabetical orders. This Functions has many 
optional arguments within the brackets. The following example shows 
basic usage of the SORT Spill Function. 

=SORT(A2:B9) 

 

Using nested Functions (two or more Functions working together), it is 
possible to combine       so that the output uses SORT, UNIQUE and/or 
FILTER. 

=SORT(UNIQUE(A2:A9)) 
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CHARTS 
 

 Chart Info 
 Chart Designs 
 Chart Examples 
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CHART INFORMATION 

Creating a chart to visualize data can bring to light new information that 
could not be seen by looking at the data itself. There are seventeen 
categories of Charts in Excel and some of the categories have up to seven 
variants. 

 

3D Pie Chart with Customizations 
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CHART DESIGNS 

Once a Chart has been created, time can be saved by selecting a preset 
design that is closer to the desired result. The designs can be selected 
from the Chart Design tools that appear on the Ribbon when a Chart is 
selected, or the paint brush icon that appear beside a selected Chart. 

Chart Designs on the Ribbon 

 

Chart Design button 

 

The Chart Designs also have the capability to change your chart to 
different sets of colours. An Excel document does have a default set of 
colours defined under the Page Layout Tab on the Ribbon, which is a good 
place to manage all the fonts and colours for the whole document. 
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CHART ELEMENTS 

Adding a label percentage to a Pie Chart or Labels on the Axis are 
examples of Chart Elements. Using the Plus sign Icon on the chart or the 
Add Elements on the Ribbon in the Chart Design Tools, it is effortless to 
further the customization of a Chart quickly. It will depend on the type of 
chart on which options are available. A Pie Graph has only three main 
options to add as Chart Elements. 

Bar Chart Showing the Add Chart Elements Button 

 

Pie Graph showing the available Chart Elements 
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FORMAT PANE 

Once the Element has been added many options are available in the 
Format Pane set of tools that can be opened by clicking on More Options 
that is found in each of the categories. 

Alternatively, it is also possible to right click on any of the parts of the chart 
and find the Format option in the Right click menu. If the bar is right clicked 
on the menu, it will say Format Series.  

 

Fill 
Effects 
Size and Alignment 
Options 

 

Once the Format Pane is open it can stay open and will show all the options 
available for the current item selected in the chart.  
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TYPES OF CHARTS 

COLUMN CHART 
Data that’s arranged in columns or rows on a worksheet can be plotted in a 
column chart. A column chart typically displays categories along the 
horizontal (category) axis and values along the vertical (value) axis, as 
shown in this chart 
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LINE CHART 
Data that's arranged in columns or rows on a worksheet can be plotted in a 
line chart. In a line chart, category data is distributed evenly along the 
horizontal axis, and all value data is distributed evenly along the vertical 
axis. Line charts can show continuous data over time on an evenly scaled 
axis, so they're ideal for showing trends in data at equal intervals, like 
months, quarters, or fiscal years. 
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PIE AND DOUGHNUT CHARTS 

Data that's arranged in one column or row on a worksheet can be plotted 
in a pie chart. Pie charts show the size of items in one data series. 
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BAR CHART 
Data that's arranged in columns or rows on a worksheet can be plotted in a 
bar chart. Bar charts illustrate comparisons among individual items. In a 
bar chart, the categories are typically organized along the vertical axis, and 
the values along the horizontal axis. 
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8AREA CHART 
An area chart combines the line chart and bar chart to show how one or 
more groups' numeric values change over the progression of a second 
variable, typically that of time. 
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XY SCATTER 
Data that's arranged in columns and rows on a worksheet can be plotted in 
an xy (scatter) chart. Place the x values in one row or column, and then 
enter the corresponding y values in the adjacent rows or columns. 
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BUBBLE 
Much like a scatter chart, a bubble chart adds a third column to specify the 
size of the bubbles it shows to represent the data points in the data series. 
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STOCK 
Data that's arranged in columns or rows in a specific order on a worksheet 
can be plotted in a stock chart. As the name implies, stock charts can show 
fluctuations in stock prices. However, this chart can also show fluctuations 
in other data, like daily rainfall or annual temperatures. Make sure you 
organize your data in the right order to create a stock chart. 

For example, to create a simple high-low-close stock chart, arrange your 
data with High, Low, and Close entered as column headings, in that order. 
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SURFACE 
Data that's arranged in columns or rows on a worksheet can be plotted in a 
surface chart. This chart is useful when you want to find optimum 
combinations between two sets of data. As in a topographic map, colors 
and patterns indicate areas that are in the same range of values. You can 
create a surface chart when both categories and data series are numeric 
values. 
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RADAR 

Data that's arranged in columns or rows on a worksheet can be plotted in a 
radar chart. Radar charts compare the aggregate values of several data 
series (data series: Related data points that are plotted in a chart. Each 
data series in a chart has a unique color or pattern and is represented in 
the chart legend. You can plot one or more data series in a chart. Pie charts 
have only one data series.). 
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TREEMAP 
The treemap chart provides a hierarchical view of your data and is an easy 
way to compare different levels of categorization. The treemap chart 
displays categories by color and proximity and can easily show lots of data 
which would be difficult with other chart types. The treemap chart can be 
plotted when empty (blank) cells exist within the hierarchal structure and 
treemap charts are good for comparing proportions within the hierarchy. 
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SUNBURST 
The sunburst chart is ideal for displaying hierarchical data and can be 
plotted when empty (blank) cells exist within the hierarchal structure. Each 
level of the hierarchy is represented by one ring or circle with the 
innermost circle as the top of the hierarchy. A sunburst chart without any 
hierarchical data (one level of categories), looks like a doughnut chart. 
However, a sunburst chart with multiple levels of categories shows how 
the outer rings relate to the inner rings. The sunburst chart is most 
effective at showing how one ring is broken into its contributing pieces. 
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HISTOGRAM 
Data plotted in a histogram chart shows the frequencies within a 
distribution. Each column of the chart is called a bin, which can be changed 
to further analyze your data. For further grouping of information such as 
demographics that group people by age, use PivotTables to prepare the 
data. 
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BOX AND WHISKER 
A box and whisker chart shows distribution of data into quartiles, 
highlighting the mean and outliers. The boxes may have lines extending 
vertically called “whiskers”. These lines indicate variability outside the 
upper and lower quartiles, and any point outside those lines or whiskers is 
considered an outlier. Use this chart type when there are multiple data sets 
which relate to each other in some way. 
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WATERFALL 
A waterfall chart shows a running total of your financial data as values are 
added or subtracted. It's useful for understanding how an initial value is 
affected by a series of positive and negative values. The columns are color 
coded so you can quickly tell positive from negative numbers. 
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FUNNEL 
Funnel charts show values across multiple stages in a process. Much like a 
Bar Graph that is center aligned.  
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COMBO 
Data that's arranged in columns and rows can be plotted in a combo chart. 
Combo charts combine two or more chart types to make the data easy to 
understand, especially when the data is widely varied. Shown with a 
secondary axis, this chart is even easier to read. In this example, we used a 
column chart to show the number of homes sold between January and 
June and then used a line chart to make it easier for readers to quickly 
identify the average sales price by month. 

 
 

DATA FOR CHARTS 

Not to be overlooked is the summary of data before a chart is created, if 
necessary. SUM, SUMIF, COUNT and AVERAGE might be some of the 
Functions utilized to prepare data before creating a Chart. A PivotTable is 
a tool that can organize and summarize large sets of data and will utilize 
Pivot Charts to visualize and analyze data. Almost all the knowledge 
gained in Charts is transferable to Pivot Charts, taught in the next level of 
training. 
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DATA VISUALIZATIONS 
 

 

 Conditional Formatting 
 Sparklines 
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CONDITIONAL FORMATTING 

Cell formats including Fill, Data format, and borders are often set by selecting 
the cells and formatting the cell to the desired look. Conditional Formatting 
not only can change the look or format of the CELL, it also has built in 
visualizations that will show up in the CELL.  

With large sets of data, it is often used to spot problems such as extreme 
values or duplicates. The Cells format can change based on a criteria or utilize 
the Data Bar visualization. 
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MANAGE RULES DIALOG 
Selecting only one cell that has Conditional Formatting on, and then selecting 
Manage Rules from the Conditional Formatting Dialog, the Conditional 
Formatting Rules Manager will show the rules for all the cells applicable to 
that specific rule. Use this dialog to change the criteria in Edit Rule, adjust 
what cell the rule applies to or delete just that rule. It is possible to see all the 
Rules on the worksheet by using the Show formatting rules in the      drop-
down found at the top of this dialog. 
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TYPES OF CONDITIONAL FORMATTING 
 

Rule Type Conditional Formatting drop-
down 

Description 

Highlight Cell 
Rules 

 

Most of the Highlight 
Cell Rule types will 
ask about the criteria 
in the dialog that 
follows. Duplicate 
Values has only a 
few options. All of 
the Highlight Cell 
Rules can customize 
to highlight in any 
colour, font styles or 
borders. 

Top/Bottom 
Rules 

 

Highlight not only 
the Top 10 or 
bottom 10, but it is 
also possible to set 
the criteria to any 
number in the dialog 
that will follow 
selecting the rule 
type. 
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Rule Type Conditional Formatting drop-
down 

Description 

Data Bars 

 

Data Bars fill the cell 
with a bar in the 
background of the 
cell. The number that 
drives the bar is still 
present. Much like a 
column graph, the 
bars are relative to 
each other. If one of 
the bars has an 
extreme value, the 
normal value cells 
will appear with a 
tiny bar. 

Color Scales 

 

Colour Scales could 
also be called a heat 
map. The first choice 
will colour the higher 
value cells with a 
green fill and the 
lower value cells will 
have the red fill. The 
third colour of yellow 
represents the 
middle average of 
the data.  
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Rule Type Conditional Formatting drop-
down 

Description 

Icon Sets 

 

Icon Sets will display 
in the Cells where 
the rules are set. 
Excel will do all the 
math, behind the 
scenes, to figure out 
what icon to display. 
 
The icon sets with 
four icons in the 
group will display an 
icon based on the 
value of the cell. 
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Rule Type Conditional Formatting drop-
down 

Description 

Formula Based 
Rules 

 

This formula is 
checking to see 
what is in Cell C46 to 
see if it is a date 
greater than today's 
date (TODAY 
Function) If it is, the 
cell will be 
highlighted in blue fill 
colour. 
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SPARKLINES 

Spark are the smallest of visualizations as they will be placed in one cell to be 
able to visualize the data in multiple cells. The Sparklines can be customized 
when the cell containing Sparklines is selected. A menu will appear on the 
Ribbon allowing the user to customize the sparkline. The examples are 
showing the custom colour for all the data points and custom highest value 
and lowest value. (Red and light yellow)  

Sparkline Tools on the Ribbon along with examples of the three types of 
Sparklines. 

 

Line- All the data points are connected by a line segment. Much like a line 
graph, the      Sparkline can be used to represent data trends over time. 

Column – Each of the data points is represented by a column. Used to 
compare categories or groupings of data values, like a column graph but is 
only capable of showing one series in a cell. 

Win/Loss 

 – The bars going in an upward direction show a positive value and the 
downward will show negative value. Using the Sparkline options, the highest 
and lowest points can be marked by a specific colour.  
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APPLYING SPARKLINES 
Select the destination cell first. Insert�Sparklines group Line. 

 

The Location Range should already be set for where the first Sparkline will 
show up. 

 

 

 

 

 

Location for first Sparkline 

Select the data 

AutoFill the following rows 
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